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CLUSTER ANALYSIS




Clustering is the technique of grouping rows together that share similar values across a
number of variables. It is a wonderful exploratory technique to help you understand the
clumping structure of your data. [MP provides three ditterent clustering methods:

* Hierarchical clustering is appropriate tor small tables, up to several thousand rows. It
combines rows in a hierarchical sequence portrayed as a tree. In JMP, the tree, also called a
dendrogram, is a dynamic, responding graph. You can choose the number of clusters that
you like atter the tree is built.

 K-means clustering is appropriate tor larger tables, up to hundreds ot thousands ot rows.
It makes a tairly good guess at cluster seed points. It then starts an iteration of alternately
assigning points to clusters and recalculating cluster centers. You have to specity the
number of clusters betore you start the process.

¢ Normal mixtures are appropriate when data is assumed to come from a mixture ot
multivariate normal distributions that overlap. Maximum likelihood is used to estimate
the mixture proportions and the means, standard deviations, and correlations jointly. This
approach is particularly good at estimating the total counts in each group. However, each
point, rather than being classitied into one group, is assigned a probability ot being in each
group. The EM algorithm is used to obtain estimates.

Atter the clustering process is complete, you can save the cluster assignments to the data table
or use them to set colors and markers for the rows. IMP Book: Multivariate Methods
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Clustering is a multivariate technique ot grouping rows together that share similar values. It
can use any number of variables. The variables must be numeric variables tor which
numerical ditterences make sense. The common situation is that data are not scattered evenly
----- through n-dimensional space, but rather they torm clumps, locally dense areas, modes, or
clusters. The identitication of these clusters goes a long way toward characterizing the

distribution ot values.

JMP provides two approaches to clustering:

» Tierarchical clustering tor small tables, up to several thousand rows

* k-means and normal mixtures clustering tor large tables, up to hundreds ot thousands ot

I'owWws. JMP Book: Multivariate Methods
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Hierarchical clustering is also called agglomerative clustering because it is a combining process.

The method starts with each point (row) as its own cluster. At each step the clustering process
calculates the distance between each cluster, and combines the two clusters that are closest
together. This combining continues until all the points are in one tinal cluster. The user then
chooses the number of clusters that seems right and cuts the clustering tree at that point. The
combining record is portrayed as a tree, called a dendrogram. The single points are leaves, the
tinal single cluster of all points are the trunk, and the intermediate cluster combinations are
branches. Since the process starts with n(n + 1)/2 distances tor n points, this method becomes
too expensive in memory and time when #n is large.

Hierarchical clustering also supports character columns. It the column is ordinal, then the data
value used for clustering is just the index ot the ordered category, treated as it it were
continuous data. If the column is nominal, then the categories must match to contribute a
distance of zero. They contribute a distance of 1 otherwise.

JMP ofters tive rules tor detining distances between clusters: Average, Centroid, Ward, Single,
and Complete. Each rule can generate a ditterent sequence of clusters. IMP Book: Mulliveriate Methads
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Clustering

Use clustering to automatically group rows having similar characteristics.

Hierarchical Clustering

Example: Cereal.jmp (Help > Sample Data)

B+ Cerenl - Hierarchical Clusker - IMP

From an open JM P° data table, select Analyze > Multivariate _ _ _
<= Hierarchical Clustering

Methods > Cluster. 4ADendrogram

Select one or more variables from Select Columns and click Y,

Columns.

If available, select a Label variable.

Select the desired method (bottom left corner) and click OK.

JMP will generate:

* A dendrogram, showing the clusters formed at each step.

* Ascree plot, showing the distance bridged each step.

* The clustering history, giving cluster statistics for each step.
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Clustering

Tips:

* To color clusters, to mark or save clusters, or to request other options, click the top red triangle.

* To dynamically change the number of clusters, click and drag one of the black diamonds left or right.
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BIRTH DEATH SUBSET DATA
JMP HELP FILE
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[%] Birth Death Subset - IMP Pro

3 N N

(=l X

Finding points that are close, have similar values

| File Edit Tables Rows Cols DOE Analyze Graph Tools Add-Ins  View Window Help
e E 2|8 B Pe PR B B BB & R
sl = Birth Death Subset >
Locked File C:\Program Files\ | (= country birth  death
Source 2009 Crude Birth and 1 AFGHANISTAN 45 19
2 ALGERIA LY 3 551 Clustering - JMP Pro
3 ARGENTIMA 18 7
4 AUSTRALLA 12 7
=/ Columns (3/0] 3 AUSTRIA 9 10 Select Columns
L count 6 BAMGLADESH 25 9
fdbirth Ve 7 BRAZIL 18 6 ~ 3 Columns
4l death 8 CAMADA 10 g ||-|:|:u_|r1trj,.r
9 CHINA 14 7 Abirth
10 TAIWAN 9 7 dldeath
11 FRAMCE 13 9
Options

Exploratory Analysis | Jim Grayson, PhD

| Hierarchical ~

Method
Average
Centroid

@ Ward
Single
Complete
Fast Ward

#| Standardize Data
Standardize Robustly

Data 1= distance matrix

Cast Selected Columns into Roles

Y, Cu:ulumn5.| birth

death
| Ordering |
| Label [ country
L By |

Action
| 0K |

| Cancel |

| Remove |
| Recall |
| Help |



Hierarchical Clustering
Method = Ward
Dendrogram
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Graph Builder
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Map shape not found: ZAIRE.
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Graph Builder
Mean(birth) & birth 8& Mean(death) & death vs. Cluster 2 — Mean(birth)

50 — Mean(death)

* hirth

* death

birth & death

Cluster 2
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The data set is a simulated data set for a consumer segmentation project. The scenario is for a
subscription based service. Data collected are 300 data points for respondents on age,

gender, income, number of children, whether they own (or rent) their homes (y/n) and
whether they subscribe to the service (yes/no).
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Method = Ward
Dendrogram

_’ Hierarchical Clustering
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SEGMENTATION ANALYSIS




Frequencies

Level Count Prob

1 107 0.35667

—— 2 64 0.21333

3 56 0.18667

4 73 0.24333

. s Total 300 1.00000

N Missing 0
4 Levels

— Quantiles Summary Statistics

}_D@—| iroasas 100.0% maximum 804862 Mean 41.19965
99.5% 793303  Std Dev 12.707427
97.5% 68.0547 Std Err Mean 0.7336636
90.0% 609415 Upper95% Mea 42643448
75.0% quartile 479262  Lower 95% Mean 39.755851

50.0% median 394877 M 300
25.0% quartile 329722
T_‘_’j 10.0% 24.3254
R L 2.5% 21.9673
20 30 40 50 60 70 80 0.5% 19.9935

0.0%

minimum

19.2599

Frequencies

Level Count Prob
Female 157 0.52333
Male 143 047667
Total 300 1.00000
N Missing 0

2 Levels

Female Male
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Quantiles
100.0% maximum
99.5%

97.5%

90.0%

75.0% quartile
50.0% median
25.0% quartile
10.0%

2.5%

0.5%

0.0% minimum

Quantiles
100.0% maximum
99.5%

97.5%

90.0%

75.0% quartile
50.0% median
25.0% quartile
10.0%

2.5%

0.5%

0.0% minimum

114278
113863
96695.8
73748.2
61436.5
520144
396109
222015
157124
-2916.2
-51834

o O 00 OoOF N WwW;m

Summary Statistics

Mean 50936.536
Std Dev 20137.549
Std Err Mean 1162.642
Upper 95% Mea 53224.534
Lower 95% Mean 48648.539
N 300

Summary Statistics
Mean 1.27

Std Dev 1.4084432
Std Err Mean 0.0813165
Upper 95% Mea 1.4300252
Lower 95% Mean 1.1099748
N 300

ownMNo

subscribe

subYes

Frequencies

Level Count

ownNo 159

ownYes 141

Total 300

N Missing 0
2 Levels

Frequencies

Level Count

subNo 260

subYes 40

Total 300

N Missing 0
2 Levels

Prob
0.53000
0.47000
1.00000

Prob
0.86667
0.13333
1.00000




Tabulate

| gender | ownHome | subscribe |
-mmﬂmm
67.29% 85.05%| 14.95%

40.63% 6| 92.19%| 7.81%

78.57% 82.14%| 17.86%

23.29% 87.67%| 12.33%

Exploratory Analysis | Jim Grayson, PhD




Oneway Analysis of age By Cluster
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. Oneway Analysis of income By Cluster
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Oneway Analysis of kids By Cluster
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e ] Multivariate

Correlations

age income
age 1.0000 0.5126
income 0.5126 1.0000
kids -0.3601  -0.0403

Scatterplot Matrix
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Graph Builder
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ITRODUCTION TO PARTITION =

-Partltlon (Analyze > Modeling > Partition) is a data
mining tool, used for data exploration and for building
predictive models.

» We will introduce the tool here, and will revisit the
topics again later.

« Example: Auto Raw Data.jmp in the Sample Data
Directory.

i}t Partition - JMP

Recursive partitioning
Select Columns
~|dSample #

y
hClaim(Y/N)
AClaim USD
hAGE
hAgeClass
hGender

Missing value categories

Validation Portion

Courtesy of Mia Stephens: DSI 2014 Presentation




=~ INTRODUCTION TO PARTITION

« JMP displays a graph with a line drawn at the overall

response rate.

Courtesy of Mia Stephens: DSI 2014 Presentation

laim(Y/N)

C

| Split || Prune ||Cculcur Paints
RSquare
0.000 20000

~All Rows

Count Gn2

20000 14677
Level Rate Prob
N 0.8800 0.8800
Y 0.1200 0.1200

Candidates

Number

N of Splits

0
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e ~— INTRODUCTION TO PARTITION

« Click the Split button. The
original observations will be
split into two nodes, or
leaves.

Interpretation:
 In the left leatf,

rune” Go HCc-I(:wr Points Number

corresponding to AgeClass = o e

Validation 0.047 6003

Young, the probability that
there is a claim is 0.3604. T e e

13997 10205202 112.7983
Level Rate Prob

* In the right leat, v o o
corresponding to AgeClass = | —L
Elder, the probabillity that e | —

Count GA2 Count G2
there |S a Clalm |S 0 097 1157 15125612 12840 8179.881
. . Level Rate Prob || Level Rate Prob
N 06396 0.6398|N 0.9030 09030
Y 0.3604 0.3602|Y 0.0970 0.0970
Candidates Candidates

Courtesy of Mia Stephens: DSI 2014 Presentation
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NTRODUCTION TO PARTITION

__«Click the Split button again, and then a third time. The
original observations will be split into two nodes, or leaves.

Jata - Partition

4~ Partition for Claim(Y/N)

~All Rows
=]
Count GA2 LogWorth
20000 14877 158.82607
Level Rate Prob
N 0.8800 0.8800
Y 01200 0.1200

~AgeClass(Young)
I

~AgeClass(Elder)
[ |

Count GA2 LogWorth Count GA2 LogWorth
1684  2196.957 29.285233 18316 11755.661 137.15102

Level Rate Prob Level Rate Prob

N 0.6419 0.6421 N 0.9019 0.9019

Y 0.3581 0.3579 Y 0.0981 0.0981

~'City(YIN)(Y) ~ICity(Y/N)(N) ~'City(YIN)(Y) ~ICity(Y/N)(N)
= I . —

Count GA2 Count G2 Count GA2 Count G2
934 1292 5325 750 77489174 10103 8381.9675 8213 2748982

Level Rate Prob| Level Rate Prob| |Level Rate Prob| Level Rate Prob
09602 09602
0.1455 0.1455|Y 0.0398 0.0398

N 0.5246 0.5250| N 0.7880 0.7881| |N
Y 0.4754 0.4750|Y 0.2120 0.2119| |Y

Candidates Candidates

0.8545 0.8545|N

Candidates Candidates

Courtesy of Mia Stephens: DSI 2014 Presentation
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US DEMOGRAPHICS
JMP HELP FILE
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Clustering - JMP Pro 7

Finding points that are close, have similar values
Select Columns
! 18 Columns

thstate

dlHousehold Income
4ig

thRegion

ﬁl:'npulation

dlEighth Grade Math
AHigh School Graduates
lGross State Product
ﬁ‘u’egetahle Consumption
dlsmokers

P hysical Activity
dlObese

ACD”EQE Degrees
Alacohol Consumption
Al atitude

Options
|Hierarchica| v|
Method
Average
Centroid
@ Ward
Single
Complete
Fast Ward
| Standardize Data
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Cast Selected Columns into Roles

v, Colur‘r‘lnsl Household Income
1Q
Population
Eighth Grade Math

| Ordering |

| Label

| State

| By |

Action
| ok |

| Cancel |

[ Rermove |
| Recall |
|  Help |




——  Graph Builder
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Constellation Plot
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Parallel Plot
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PARTITION USING EXAMPLE DATA SET




¢ Partition - JMP Pro

Recursive partiticning
Select Columns

*! 7 Columns

bhCluster
ﬁage
thgender
Aincome
liids
thownHome
hzubscribe

#| Informative Missing
| Ordinal Restricts Order
Method

Validation Portion | n|

| Decision Tree 'r|

Exploratory Analysis | Jim Grayson, PhD

Cast Selected Columns into Roles

|V, Response| |l Cluster

| X, Factor |I|.gen|:ler

income
Al kids

ik ownHome
ik subscribe

| Weight |
| Freq |
| Validation |

| Remaowve |

| Recall |

Help




First Split

= All Rows

) [

Count G"2 LogWorth
300 81270061 101.10806

Lewvel Rate Prob

1 0.3567 0.3567

2 02133 0.2133

3 01867 0.1867

4 0.2433 0.2433

*income<35546.2883

Count G*2 LogWorth
63 43.952844 35776478

Lewvel Rate Prob
1 0.0000 0.0056
2 0.0000 0.0033
3 0.8882 0.8779
4 01111 01132

Exploratory Analysis | Jim Grayson, PhD

*lincome>=35546.2883
[
Count G*2 LogWorth
237 506.50368 56.401911

Level Rate Prob
1 04515 04511
2 0.2700 0.2698
3 0.0000 0.0008
4 0.2785 0.2783




*income<35546.2883
(]

*2 LogWorth

344 35776478
Rate Prob

01111 01132

Tkids<1 Tkids>=1
[ [
Count G2 LogWorth Count G2
24 28974588 3. 2 39
Level Level

[FTRY

I

Candidates

TownHomelownYes) ||'™ownHome(ownNo)

Count Gn2 Count G"2
10 12217286 14 0

Level Rate Prol Lewvel Rate Prob
0000 0. 0 0.0194
0 0.0116

[EWR )

0.7000 0.0157

Candidates Candidates

oS
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~lincome>=35546.2883
[

Count G2 LogWorth
237 50650368 56401911
Level Rate Prob
1 04515 04511
2 0.2700 0.2698
3 0.0000 00008
4 0.2785 0.2783

 kids>=2
S —
Count G"2 LogWorth

89 10569645 11834471

Level Rate Prob
1 0.2809 0.2818
2 07191 0.7135
3 0.0000 0.0019
4 0.0000 0.0027

*kids>=3 * kids<3

[ [ —

Count G2 Count G2 LogWorth
51 9843014 38 50.016359 6.7394684

Level Rate Prob Lewvel Rate Prob

1 G-B185—0:0261 1 0.6316 06246

2 0.9804 09667 2 0.3684 0.3659

3 0.0000 0.0029 3 0.0000 0.0039

4 0.0000 00043 4 0.0000 00057
Candidates | | |

*'ownHome{ownYes) |['™'ownHome(ownNo) Tincome>=68364.62976
0
Count G"2 Count G"2 Count G2
17 15843975 21 0 32 14962666

Level Rate Praob Level Rate Prob Level Rate Prob

1 01765 01880 || 1 1.0000 09720 b 0.0625 00721
2 08235 07932 (2 £-0000—6-0178 2 0.0000 0.0054
3 00000 00076 | 3 0.0000 0.0062 3 0.0000 0.0041
4 00000 00112 | 4 0.0000 0.0091 4 09375 09184
Candidates Candidates Candidates
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*kids<2
SR ' (| [
- Count G*2 LogWorth

148 203.43845 18.841168

Lewvel Rate Prob
1 0.5541 0.5528
2 0.,0000 00015
3 0.0000 0.0011
4 04452 04446

Tkids<1 Tkids>=1
[ — [
Count G*2 LogWorth Count G2

97

Level

121.5523 33287301
Rate Prob

51

Level

0
Prob

Rate

1 0319 0.3203 1 1.0000 09882
2 0.0000 0.0020 2 0.0000 0.0038
3 0.0000 0.0015 3 0.0000 0.0029
4 0.6804 0.6762 4 0.0000 00051

| | | Candidates
Tincome:>=068364.62976 Tincome<68364.62976
ol |
Count G2 Count G*2 LogWorth
32 14962666 65 89353823 0.7565989

Rate Prob Rate Prob

Level Level

1 0.0625 00721 1 0.4462 04451
2 0.0000 0.0054 2 0.0000 0.0027
3 G0000 U00a L 3 0.0000 00021
4 08375 091584 4 0.5538 0.5501

Candidates
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Column Contributions

Number
et of Splits G/r2
kids 4 340.069361
income 4 294468882
ownHome 2843608
subscribe 4.83988976
gender 0
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Response Prob

Leaf Label 1 2 3 4
income<35546.2883 Akids <1 &ownHome{ownYes) 00264|: 1 0.0151 ERE 0.2994"_15 | 06578 :
income=< 35546 2883 Rikids <1 &ownHome[ownho) 00194[ . | 00114 . . | 00533 00157 ¢ ¢
income«<35546.2883 Ackids> =1 0.0080 - n.nm} © | 0.9814 In.nnﬁa .
income> = 355462883 Alkids> = 2 Bikids> = 3 Bsubscribe(subMo) 0.006d] - 00029 - |ooo43):
income>=35546.2883 & kids> =28 kids> =3 &subscribe(subYes) 0.220
nHome(own'es) 0.1883

0.985
07230 IR0 Jo.0228|:::: |op0334):
07932 "1 J0.0076: ! : . n.nnz&; 535

T [ 072 noi2el o lonngal il nngd

incomes =35546.2883 Aikids < 2&kids <1 &lincome> =68364.62976&income> =T78019.71522 0.0174 00080 ¢ |0.0062|: | 09684 |
income> =35546,28838kids < 2Bikids <1 &income» =68364,62976 &income<78019.71522 01679 1 0.0115 - |o0088 | - o820 ]
incomes =35546.2883 & kids< 28 kids<1 &lincome<F8364,62076 8.ownHome(ownYes) &lincome>=A0168.28251 00317 : 00120 | 0.0092| ' |0.9470

income>=35546.2883 & kids< 28 kids<1 B&lincome<68364.62976 & ownHome{ownYes ) &income< 6016828251 0463$_'_'J © | 0.0047(. ... [ 00036 05279 _'_'_l
income==35546.2603 &kids < 26ikids <1 Blincome=b68364 629768 ownHomelownMao) 06154 L' [p.0064|::: | 00049 ! 0373300 !

income> =35546.2883 8ikids <2 &ikids=> =1 0.9882 D.0038 | 000 | 000290 | 00051
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